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1. INTRODUCTION TO WRITE

The Write Activity serves as the document creation Activity in Sugar. Its simple interface
provides an easy starting point for children, presenting tools that make writing a story, poem, or
essay simple and straightforward. It also supports tools for inserting images, creating tables, and
performing layout operations.

The Write Activity utilizes the Journal—your work is automatically saved. The Activity also
supports collaboration in the form of peer editing, group storytelling, etc.

The Write Activity can be used to open and edit most common file formats, including ODT, DOC,
RTF, TXT, and HTML.

TIP OF THE HAT

Write is based upon Abiword; the Sugar port was done by J.M. Maurer, Martin Sevior, Tomeu
Vizoso and Robert Staudinger

GETTING STARTED
2. The Basics

3. Write Basics

4. Collaborating



2 - THE BASICS

As is the case with most Activities, Write can be launched in multiple ways:

from the Home View
from the Journal

from an invitation
from a shared session

OPENING FROM THE HOME VIEW

RESUME EDITING AN EXISTING DOCUMENT

From the Journal you can open an existing Write document by clicking its icon.
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ACCEPTING AN INVITATION TO WRITE

You can also join a shared Write session by accepting an invitation from someone else. To do this
you must accept the invitation from the top of the Frame (or upper-left corner of the screen).

Invitations appear in the upper-left corner of the screen in all views.



JOINING A SHARED WRITE SESSION

If Write is shared in the Neighborhood View, you can join the shared session by clicking the Write
icon.




3. WRITE BASICS

When you start Write, you can immediately begin typing. Text is input behind the cursor, which
appears as a vertical line like this | on the screen.
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We like to think that a child's play is unconstrained--but when children
appear to feel joyous and free, this may merely hide from their minds their
purposefulness; you can see this more clearly when you attempt to drag
them away from their chosen tasks. --Marvin Minsky, The Emotion Machine

NAMING YOUR DOCUMENT

You can name your document by typing into the field found on the Activity tab in the upper left

hand corner of the screen.
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Below, the name of the document has been changed to "The Emotion Machine."
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INSERTING PICTURES

You can place pictures in your text either from the Journal or the clipboard.

From the Journal: Click the Image tab, and then click the Insert button to open a dialog box for
searching in the Journal for Images.
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SEARCHING THE JOURNAL FOR IMAGES
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Here is a picture of the author for this quote, Marvin Minsky.
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You can reposition the image by clicking on it, then dragging it. Gray boxes in each corner work
like "handles" you can drag to resize (rescale) the image.
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Tip: You can include an image of a web page in a Write document. Type alt + 1 while in the
Browse Activity to save an image of a web page in the Journal. (It will be named "Screenshot").
Insert the screenshot into your Write document using the Insert Image dialog.

EDITING
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Just like other word processors on computers, Write supports copy, paste, cut, undo and redo.
Buttons are on the Edit tab. Also, you can use keyboard shortcuts: ctrl + c (copy); ctrl + v
(paste); ctrl + x (cut); ctrl + z (undo); and ctrl + y (redo).

Highlight the text you would like to copy by dragging the cursor across it with the left mouse-
button depressed. This example shows the words "Marvin Minsky" highlighted.
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Click the Copy button or press ctrl + c. Sugar copies the text to the clipboard.
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Press ctrl + v or click the Paste button to insert text. Sugar pastes the text where the cursor is
blinking.
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Marvin Minsky

You can also drag images from the clipboard or drag ones that are already pasted into the
document.
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FORMATTING CHARACTERS

Write supports a number of character formats: bold, italic, underline, color, point size (smai and

Iarge), and font family (e.g., serif and sans-serif).
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Marvin Minsky

Change the selected text using the pull-down menu on the Text tab.
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Bold text by clicking the Bold button or pressing ctrl + b.
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Italicize text by clicking the ltalics button or pressing ctrl + i.
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Underline text by clicking the Underline button or pressing ctrl + u.
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Change color by opening the color palette (click the square on the Text tab).
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Pick a Color ]

Hue: o B Bed: 245 B
Saturation: a7 B Green: 6 B
Value: 96 B Blue: 5 B

-° Color pame:  #F50606

Click on the multicolored circle or triangle to select a color. Click the OK button when you have
made your choice.
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Marvin Minskyj

Use the pull-down menu to select the font family.
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FORMATTING PARAGRAPHS

Paragraph alignment is set with the pull-down menu on the Edit tab.

The example below is left justified.
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The example below is right justified.
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The example below is centered.
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The example below is justified (it looks like a newspaper column).
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Formatting with styles

The drop-down menu on the Format tab has additional paragraph styles, such as bulleted list,
dashed list, numbered list, and others. You can try them all by clicking the drop-down list.
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INSERTING TABLES

Use the Table tab to insert tables into your document. By dragging the mouse across the left-
hand icon (the grid), you can select the size and dimensions of the table. Other buttons let you

add or remove rows and columns.
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Marvin Minsky
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Note: Tables are a bit finicky, meaning they may not behave exactly as you expect. Take care
when you use them and don't rely on a table for meaning.

SAVING YOUR WORK

Write automatically saves your work to the Journal. You can resume editing a document clicking
its icon in the Journal.

By default, Write stores documents in the ODT file format. ODT is the OpenDocument format
for text documents and this format can be opened with OpenOffice.

However, there are times when you may prefer to output your document in another format.
The Keep button lets you save a copy of your document in rich text (RTF), hypertext (HTML), or
plain text (TXT) formats in the Journal.
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Keep Ctrl+S

Rich Text (RTF)
Hypertext (HTML)
Plain Text (TXT)

Note: Only use the Keep button when you want to store a new,
separate copy of your document. Each time you click this button a new Journal entry will be
created with the same name as the present Activity. You are not switched to the new Activity,
so be sure to go to the Journal and rename it to a distinguishing title so you don't get confused.
The keeping feature is useful when you want to create a series of separate documents based on
the current Activity.

Importing documents
Write can import a variety of file formats, including Microsoft Word® DOC files. If you have a

DOC file in your Journal (or on removable media), you can open it in Write using the Resume
button.

In the example below, a Word document is opened in Write from a USB storage device.
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2008 Women2Women
Leadership Conference and Cultural Exchange

The Women2Women International Leadership Conference and Cultural
Exchange (W2W) is a program sponsored by Empower Peace. The
conference is an opportunity for young women from around the world
{ages 15-19) to meet with national and international women leaders
and participate in a series of leadership development workshops and
panel discussions.

The goal of this conference is to provide young women with the
opportunity to learn, network and acquire the leadership and
professional development skills needed to succeed. The conference is
our effort to empower young women to become our future leaders.

The 2008 Participants have been selected from the following
countries:

Azerbaijan Lebanon
Cyprus Pakistan
Erunt Palactine

VIEW

Write lets you zoom into and out of the page.
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4. COLLABORATING

The Write Activity supports collaborative (peer) editing, which means that multiple people can
edit the same document at the same time.

To start a collaboration, either:

e send an invitation, or
e share with the Neighborhood

As with all Sugar Activities, invitations go to specific individuals, but sharing is open to anyone in
the Neighborhood View. Please see the chapter on Collaboration in the Sugar Manual for more
details about invitations and sharing.

OPEN A DOCUMENT

Format
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Marvin Minsky

SEND AN INVITATION

Go to the Neighborhood View or Group View to share your document. Click a friend's XO icon to
send an Invite request.
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RECEIVE AN INVITATION

Once you've invited your friend, have him or her click the Write icon in the Frame that's the
color of your Sugar XO icon to accept the invitation.

ACCEPT THE INVITATION

Have your friend click the Write icon in the Frame and choose Join.
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Write

Q Join

SHARING WRITE

Once you and your friends have shared the Write Activity, everyone sees the same document.

Format
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Marvin Minsky

TWO PEOPLE TYPING

No need to take turns. Changes appear simultenously in all copies of the shared document.

24



T 12 ~  Dejavu Serif v =

Activity Image Table Wiew

Format

We like to think that a child's play is unconstrained--but when children
appear to feel joyous and free, this may merely hide from their minds their
purposefulness; you can see this more clearly when you attempt to drag
them away from their chosen tasks. --Marvin Minsky, The Emotion Machine

Zane: My text is blue
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Marvin Minsky
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Zane: My text is blue
Marvin: My text is red|

Marvin Minsky

The Journal entry has the color of the person who shared the document (see below).
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The detail view has the icon of the person who shared the document (see below).

© Back

v Q The Emotion Machine Seconds ago

_ e Description:

Peer editing with Marvir]

Participants

NOTE TO PARENTS AND TEACHERS

Collaboration is a powerful feature of Write, but it is recommended that when you do
collaborate, keep the number of people editing the same document to just 2-3 people.
Otherwise, there tend to be delays that cause the document to get out of synch from one
computer to another. Also, try to avoid using too many large pictures or tables when
collaborating, as these objects tend to get scrambled.
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TUTORIALS

5. Peer Editing

6. Group Storytelling

7. Letter to the Editor

8. E-mailing a Write Document
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5 . PEER EDITING

The late Don Murray taught generations of journalists how to write. He had three simple rules
for great writing:

1. revise
2. revise
3. revise

Revision is an essential part of the writing process and one of the easiest and most effective
ways to revise is to share the burden of editing among your friends. Hand your writing to a
friend, who will read it and make comments and suggestions. You return the favor by doing the
same for your friend's writing.

A peer is a classmate, or someone your age, or someone who shares an interest with you.

Editing is the process of offering compliments about what you like, honest critique of what you
don't like or don't understand, and also making corrections, such as identifying spelling mistakes
or grammatical errors.

Thus, peer editing is simply editing by a peer!

Writing is difficult and it is easy to become discouraged, so it is important that a peer editor
make positive comments. Always start by saying something you like about the writing.

At the same time, it is important to be honest and thorough in your criticism. We can learn
though acknowledging and correcting our mistakes, but we often need feedback to become
aware of where we can make improvements in our writing.

USING WRITE FOR PEER EDITING

It is fun and easy to use Write for peer editing. Simply share your document with a friend, who
then can make comments and corrections directly in your document.

Steps:

Open the document you are working on in Write by "resuming" it from the Journal.

1.

2. Go to the Neighborhood View.

3. Find your peer's XO icon.

4. Use the hover menu to send an invitation to join Write.

5. Go back to the Write Activity and watch as your friend makes edits.

6. Thank your friend for helping you learn to be a better writer.
Alternative

You can have two instances of Write open so that you can be editing your friend's document
while your friend edits yours.

Steps:
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Open the document you are working on in Write by "resuming" it from the Journal.
Go to the Neighborhood View.

Find your peer's XO icon.

Use the hover menu to send an invitation to join Write.

Wait for your friend to sent you an invitation to join Write.

Accept the invitation.

Edit your friend's document, remembering to be positive, yet thorough.

Thank your friend for helping you learn to be a better writer.

OOV WN =

Hint

When editing, chose a color that stands out, such as red or blue. This color difference makes it
easier for your friend to see what changes you have made.
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6 . GROUP STORYTELLING

The Dadaists, a cultural movement that began in Europe towards the end of World War | (1916)
invented a number of art-construction techniques, including collage and photo montage. Many of
their works were collaborative, including exquisite corpse, a method by which a collection of
words or images was collectively assembled. Each collaborator adds to a composition in turn,
either by following a rule or by being allowed to see the end of what the previous person
contributed.

A shared instance of Write can be used in a similar way to create a collaborative story, poem,
rhyme, or group stream of consciousness.

USING WRITE FOR GROUP STORYTELLING

It is fun and easy to use Write for group storytelling. Simply share a document with a group of
friends (or your class); take turns opening the document and adding to the story.

Steps:

Open a document in Write.

1.

2. Type in a rule on the first line for everyone to follow. (Some examples are listed below.)

3. Go to the Activity tab.

4. Select "Share with Neighborhood".

5. One at a time, each person in the group should open the shared document by clicking it in
the Neighborhood View.

6. During their turn, they should follow the rule to add to the end of the story.

7. They should exit Write after they have added to the story. (Important: the person who

originally shared the document should not exit Write until everyone has taken their turn.)
8. After each person has added to the story, the person who started the story should read it
aloud to the group.

Examples

Add a sentence that continues the theme of a story.

Add a new sentence that starts with the last word of the sentence that comes before it.
Add a new word that begins with the same letter as the last letter of the word before it.
Add an adjective after a noun, a noun after an adjective.

Add a word with one more letter than the word before it (this gets hard for a large group!)
Add words in alphabetical order.
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zebra
apple
elephant
tree
eagle

eye

easy

yak
kangaroo|

TELEPHONE

You can use Write to play a variant of the Telephone Game (See
http://en.wikipedia.org/wiki/Chinese_whispers).

Rather than passing a sentence around the room by whispering a phrase, each successive
participant in turn repeats a short story though words and pictures. The cumulative errors that
result from the interpretation of illustrating a story and subsequently captioning a picture is both
amusing and an opportunity to discuss narrative techniques.

Steps:
Alternate between writers and illustrators.
1. Writer:
A. Create a new document in Write.
B. Write a short story—two or three sentences.
C. Share the story with the next student.
2. lllustrator:
A. Open the shared document and read the story.
B. Create a new document in Paint.
C. Create a picture to illustrate the story.
D. Share the picture with the next student.
3. Continue until every student has either written a story or made a drawing.

4. Share the results with the class in the order in which the stories were created.
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7. LETTER TO THE EDITOR

Writing is one of the most powerful means of personal expression ever invented. The expression,
"the pen is mightier than the sword" has rung true through out history.

It is important that the world hears your voice and you can make your voice heard, whether
through a blog, a letter to the editor, a comment on a page in the Wikipedia, or by some other
means. Write gives the power of expression as well as the means to share your expression with
others.

If you want to write a letter to the editor, you first need to look in the newspaper or on the
paper's web site to find their e-mail address for letters. Some newspapers have a policy of
publishing all appropriate letters sent to the editor, but most are more selective. All require you
to include your complete name, address, and a contact telephone number. You can, however,
request that your letter be published with "name withheld" if you want. Most editors call you to
verify that you really did write the letter before printing it. They also reserve the right to edit
your letter to fit the available space on the page.

If you keep your letter short and to the point, you have a better chance of experiencing the thrill
of seeing your own words in print. Good luck!

EXAMPLES

Children in the Galadima School in Abuja, Nigeria used Write to write letters to the president of
Nigeria with suggestions about how he could improve the conditions of school for all the children
of Nigeria.

Children in Ban Samkha, Thailand used Write to share ideas with their teachers, their families,
and their community.

Children in Khairat, India use Write (and Record) to survey their village and compile a report to
the community.

Children in Uruguay and Colombia are writing blog entries, also known as blogging. Blog entries
are typically chronologically ordered essays or stories.

OTHER LEARNING ACTIVITIES

Start a school newspaper.

Write an autobiography.

Interview someone from your community.

Write an article for the Wikipedia about your community.
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8. E-MAILING A WRITE DOCUMENT

When you have finished writing and editing a letter in Write, you can transfer it to e-mail.

To do this, begin by opening the Write Activity and composing your letter. When you finish
writing it, click the Edit tab at the top of the page. Select the Copy icon (the third from the left
at the top) and click it. Then open the Browser and go to your e-mail account. Start a new
message. Press ctrl + v to paste the text from Write to your e-mail message. Once you paste,
the e-mail contains the letter you wrote in Write.

ATTACHING PHOTOS

If you would like to attach a photo from the Record Activity to your e-mail, you can do that too.
Your e-mail should have something that says "Attach files" or something similar. Select it. It
offers you the opportunity to "Browse" (they are referring to looking for the photo, not to the
Browse Activity). Click that. It opens the Journal page for you. Select the photo you want and
click on it. Then click "Attach". It is then ready to send with your e-mail.

APPENDICES
9. License
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9 . LICENSE

All chapters copyright of the authors (see below). Unless otherwise stated all chapters in this
manual licensed with GNU General Public License version 2

This documentation is free documentation; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free Software Foundation; either
version 2 of the License, or (at your option) any later version.

This documentation is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this
documentation; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor,
Boston, MA 02110-1301, USA.
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Free manuals for free software

GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it.
By contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users. This General Public
License applies to most of the Free Software Foundation's software and to any other program
whose authors commit to using it. (Some other Free Software Foundation software is covered by
the GNU Lesser General Public License instead.) You can apply it to your programs, too.
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When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free
software (and charge for this service if you wish), that you receive source code or can get it if
you want it, that you can change the software or use pieces of it in new free programs; and that
you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights
or to ask you to surrender the rights. These restrictions translate to certain responsibilities for
you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must
give the recipients all the rights that you have. You must make sure that they, too, receive or
can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license
which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands
that there is no warranty for this free software. If the software is modified by someone else and
passed on, we want its recipients to know that what they have is not the original, so that any
problems introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the
danger that redistributors of a free program will individually obtain patent licenses, in effect
making the program proprietary. To prevent this, we have made it clear that any patent must
be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the
copyright holder saying it may be distributed under the terms of this General Public License. The
"Program", below, refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law: that is to say, a work
containing the Program or a portion of it, either verbatim or with modifications and/or translated
into another language. (Hereinafter, translation is included without limitation in the term
"modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they
are outside its scope. The act of running the Program is not restricted, and the output from the
Program is covered only if its contents constitute a work based on the Program (independent of
having been made by running the Program). Whether that is true depends on what the Program
does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it,
in any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to
this License and to the absence of any warranty; and give any other recipients of the Program a
copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work
based on the Program, and copy and distribute such modifications or work under the terms of
Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed
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the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part
contains or is derived from the Program or any part thereof, to be licensed as a whole at
no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to print
or display an announcement including an appropriate copyright notice and a notice that
there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy of
this License. (Exception: if the Program itself is interactive but does not normally print such
an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work
are not derived from the Program, and can be reasonably considered independent and separate
works in themselves, then this License, and its terms, do not apply to those sections when you
distribute them as separate works. But when you distribute the same sections as part of a
whole which is a work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire whole, and thus to
each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative
or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or
with a work based on the Program) on a volume of a storage or distribution medium does not
bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you also do
one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party,
for a charge no more than your cost of physically performing source distribution, a
complete machine-readable copy of the corresponding source code, to be distributed under
the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

c) Accompany it with the information you received as to the offer to distribute
corresponding source code. (This alternative is allowed only for noncommercial distribution
and only if you received the program in object code or executable form with such an offer,
in accord with Subsection b above.)
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The source code for a work means the preferred form of the work for making modifications to
it. For an executable work, complete source code means all the source code for all modules it
contains, plus any associated interface definition files, plus the scripts used to control compilation
and installation of the executable. However, as a special exception, the source code distributed
need not include anything that is normally distributed (in either source or binary form) with the
major components (compiler, kernel, and so on) of the operating system on which the executable
runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated
place, then offering equivalent access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not compelled to copy the source
along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program
is void, and will automatically terminate your rights under this License. However, parties who
have received copies, or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Program or its derivative works. These
actions are prohibited by law if you do not accept this License. Therefore, by modifying or
distributing the Program (or any work based on the Program), you indicate your acceptance of
this License to do so, and all its terms and conditions for copying, distributing or modifying the
Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the
Program subject to these terms and conditions. You may not impose any further restrictions on
the recipients' exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your
obligations under this License and any other pertinent obligations, then as a consequence you
may not distribute the Program at all. For example, if a patent license would not permit royalty-
free redistribution of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to refrain entirely
from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance,
the balance of the section is intended to apply and the section as a whole is intended to apply in
other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right
claims or to contest validity of any such claims; this section has the sole purpose of protecting
the integrity of the free software distribution system, which is implemented by public license
practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to
the author/donor to decide if he or she is willing to distribute software through any other system
and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the
rest of this License.
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8. If the distribution and/or use of the Program is restricted in certain countries either by
patents or by copyrighted interfaces, the original copyright holder who places the Program under
this License may add an explicit geographical distribution limitation excluding those countries, so
that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public
License from time to time. Such new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number
of this License which applies to it and "any later version", you have the option of following the
terms and conditions either of that version or of any later version published by the Free
Software Foundation. If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserving
the free status of all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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